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Aim

 

This tutorial is designed to introduce the user to the concept of topologies, 

how to create them, how to edit them and how to manipulate mid-ocean 

ridge topologies. 

Included files 

 

Click here​ to download the data bundle for this tutorial. 

ftp://ftp.earthbyte.org/earthbyte/GPlates/TutorialData_GPlates2.0/9.3-Topologies_Introduction.zip


The tutorial dataset (9.3-Topologies_Introduction.zip) includes the following 

files: 

Rotation File 1: Caltech_Global_20100723.rot 

 

Reconstructed Geometries: 

Caltech_Global_20100723_NO_PLATEPOLYGONS.gpml 

Coastline file: Seton_etal_ESR2012_Coastlines_2012.1_Polygon.gpmlz 

 

Rotation file 2: Seton_etal_ESR2012_2012.1.rot 

 

Plate polygon file: Seton_etal_ESR2012_PP_2012.1.gpmlz 

 

Background 

 

GPlates​ enables the user to create traditional geophysical features like hot 

spots, mid ocean ridges, and large igneous provinces, with static geometries 

such as points, lines, and polygons, respectively. GPlates also has the ability 

to create specialized topological features with dynamic geometries. 

What is a topology? What is it used for? 

A topology is specialized feature type whose geometry is determined not by 

a static list of vertices, but rather from the composition of geometries from 

other, regular features. A topology does not contain any vertices itself, but 

instead contains a list of references to features. During the reconstruction 

process this ​boundary list​ is used to gather up the geometry of the boundary 

features, and form a complete closed polygon for the topology. 

 

Using topology features, we have developed the concept of a "Continuously 

Closed Plate" (CCP), such that, as each margin moves independently, the 

plate polygon remains closed geometrically as a function of time. This 

methodology is a new improvement for combining kinematic plate models 

with geodynamic models. 

 

Topologies are primarily used to model the large scale tectonic plates. Future 

versions of GPlates will use these topologies to model deforming regions of 

the Earth’s crust. 

 

 

 



 

Figure 1:​ Schematic of the generic features that are incorporated into the Continuously 

Closed Plate (CCP) algorithm. Red dots represent dynamically computed intersections 

between plate boundaries. 

 

How does GPlates form a dynamic geometry? 

 

The following diagrams show how GPlates creates a dynamic geometry for a 

simple hypothetical polygon, for two reconstruction times, 0 Ma, and 10 Ma. 

 

A: 0 Ma B: 10Ma 



 

Figure 2:​ Hypothetical plate polygon from four intersecting lines at two times. Base 

features are drawn in blue. Plate polygon is outlined in grey, with grey dots showing 

polygon’s vertices. Red crosses have been added in the figures to highlight dynamically 

computed intersection points, relative to base features' vertices. First line on the boundary 

list is highlighted white (North Line); last line is highlighted in black (East Line)  

A:​ Reconstruction at 0 Ma, the initial configuration of lines, intersection points, and resolved 

polygon vertices.  

B:​ Reconstruction at 10 Ma, the lines have been reconstructed, new intersection points 

computed, and the polygon resolved. Some vertices from the North Line are no longer used 

as it moved relative to the West Line. 

 

In both reconstructions the East Line contributes none of its original vertices, and only the 

intersection points are used (no vertices exist on the East Line between the intersection 

points). 

 

For more information about the Topology Tools in GPlates, see ​Tutorial 5.1​, 
or the ​GPlates User Manual​. 

https://docs.google.com/document/d/1qVHL-V4HSpcZeAiYBqUtbrwRNQcWLfLrTI0C9d7cVRI/pub
http://www.gplates.org/user-manual/


Exercise 1 – Creating a Topological Closed Plate Polygon 

 

The Build Topology Tool is used to create new topology features from 

existing regular non-topological features. You will select a series of features, 

in an ordered fashion, moving around the intended boundary of the 

topology. 

 

1. Open GPlates and load the following files using File > Open Feature 

Collection: 

- Caltech_Global_20100723_NO_PLATEPOLYGONS.gpml 

- Caltech_Global_20100723.rot 

 

2. Go to Features > Manage Colouring and on the left hand panel of the 

Draw Style window, select FeatureType (Figure 3) 

 

 

Figure 3:​ DrawStyle Window, selecting colour by Feature Type 

 



The basic colour scheme is now: 

- Green for Mid Ocean Ridges 

- Blue for Subduction Zones and isochrons 

- Purple for Fracture Zones 

(see the GPlates manual for more info on the colour schemes available). 

 

3. Orient the globe to focus on the Nazca plate and zoom in a little (Figure 

4). 

 

 

Figure 4:​ Globe oriented to show the Nazca Plate, features coloured by Feature Type 

 

4. Change the reconstruction time to 3 Ma and play the animation to present 

day. See how the plate margins move 



 

5. Select the Topology Tool , and then the Build New Boundary 

Topology Tool . The topology tool is now activated and the new 

topology will initially have an empty list of sections (as you add sections to 

the topology, the Topology Sections Table will become populated with the 

features) 

 

Now we will select features by clicking on them on the Globe. Please note 

that you do not have to switch to the Choose Feature Tool. The Build New 

Boundary Topology Tool   is a specialized version of choosing features 

and is located within the Topology submenu or can be selected by pressing 

‘b’ on the keyboard. 

 

6. Select the western margin of the Nazca plate, which is a digitized ridge 

created from an isochron.  

 

Notice that several features may now appear in the Clicked table below the 

globe. This table lists all the features found under the mouse click point. If 

more than one feature is under the click point, you can use the Clicked Table 

to further refine your selection to the proper feature. 

 

7. Once you have identified the desired feature, click the ‘Add’ button in 

Section tab in the right panel (Figure 5).  

 

The feature reference is transferred to the Topology Boundary Sections table 

in the bottom panel below the globe, and placed on the working list of 

boundary features for the new plate polygon.  

 

At this point there is only one element on the boundary list, so the plate 

polygon will simply close using only that feature and its vertices (hence we 

see the black line from joining the ends of the green line). 

 

 



 

Figure 5:​ Adding the first section of the Nazca Plate (Step 7) 

 

We will now continue creating the intended boundary of the new plate by 

selecting a feature to focus it, and then clicking Add to Boundary to insert it 

into the Topology Section Table. 

 

We recommended creating a new topology by cycling around the boundary 

systematically (either a clockwise or counter-clockwise) and appending 

features to the end of the Topology Sections Table. In this example we will 

close Nazca in the counter-clockwise direction. 

 

8. Choose the southern margin of the plate (another ridge from isochron 

data) and add it to the list (Figure 6). 

 

Notice how now the south west corner of the plate is formed from the 

intersection of the two line data features, but it "wraps back upon itself" 

 

With only two features on the list, the internal CCP algorithm chooses the 

shortest path to close the polygon and it results in a little wedge. This will be 

corrected as more features are added. 

 

 



 

Figure 6:​ Build the Nazca Plate - Adding the second section results in a green and blue line 

being highlighted (the start and end of the topology so far); this will be corrected as more 

sections are added (Step 8) 

 

 

9. Continue along the eastern Margin, selecting and adding the South 

American Trench (Figure 7). 

 

Notice how the collection of vertices that form the work-in-progress plate 

polygon changes - the polygon uses most of the western margin, an 

intersection point with the southern margin, the central portion of the 

southern margin, an intersection point with the trench, and most of the 

trench. 

 

Notice that the north margin has yet been defined, so the GPlates simply 

closes the gap​ by connecting the two features. 

 

 



 

Figure 7:​ Build the Nazca Plate - Adding the third section results in good intersections in 

the south, and an automatic closing in the north (Step 9). 

 

 

10. To complete the plate closure, zoom in to the northern half of the plate 

area (Figure 8). 

 



 

Figure 8:​ Build the Nazca Plate - zooming into the northern section of the Nazca Plate 

 

We note that the north east region of the plate appears complex, however in 

this example, we will create a simple topology. 

 

11. Click on the northern margin (a ridge isochron) and add it to the 

boundary (Figure 9). 

 



 

Figure 9:​ Northern ridge isochron section selected. 

 

Once you are satisfied with the entries in the Topology Sections Table, and 

the resulting geometry of the Closed Plate Polygon, we need to create our 

new topology. 

 

12. Select the ‘Create…’ button on the Topology Tab of the Topology Tools 

panel (on the right hand side of the screen). 

 

13. In the first step you will choose the Feature Type of the new Topology. 

Select: gpml:TopologicalClosedPlateBoundary. 

 

The next step is to assign other basic property values to the Topology.  



 

14. The geometry type is "Boundary" (this value is automatically selected for 

you) 

 

15. Set the other basic feature properties - Plate ID, Begin Time, End Time, 

Name (Figure 10). 

 

- Enter 911 for the Plate ID corresponding to the Nazca plate. 

- Enter a Begin Time of 3 Ma; an End Time of 0 Ma; 

- Enter something like "Nazca Example" for the name of the new plate 

polygon. 

 

 

Figure 10:​ Build the Nazca Plate - Adding basic properties to the Plate Polygon Feature 



(Step 15). 

 

16. Select Next, Next, and then we have to save the feature to a feature 

collection. 

 

17. We will save this topology into a new feature collection. 

 

You may notice that nothing appears to have changed on screen. 

 

18. Open the Layers Window (Window > Show Layers or Ctrl+L). 

 

Notice that our new layer is pink, and is situated below the green layer that 

we created the topology from. 

 

19. Make the green layer invisible, and notice that our new topology is now 

visible (Figure 11). 

 



 

Figure 11:​ Nazca plate topology visible 

 

Another way to make this visible with the reconstructed geometries, is to 

change the order of the layers in the Layers window. In GPlates, the layer 

that is at the top will appear on top of all other layers. 

 

20. Drag the pink layer so that it sits above the green layer in the Layers 

window and make both layers visible (Figure 12). Note that we can see our 

new topology as well as the spreading ridges and other reconstructed 

geometries. 

 



 

Figure 12: ​Nazca plate topology on top of existing geometries 

 

For more information about creating new topologies, see ​Tutorial 5.1​, or the 

GPlates User Manual​.  
 

Exercise 2 – Editing an Existing Topology 

 

 

The Edit Topology Tool  is the tool used to edit existing topology 

features. Under this tool you will load an existing topology into the Topology 

https://docs.google.com/document/d/1qVHL-V4HSpcZeAiYBqUtbrwRNQcWLfLrTI0C9d7cVRI/pub
http://www.gplates.org/user-manual/


Sections Table, and make edits to that ordered list of features.  

 

We will edit the Nazca plate topology we created in Exercise 1 to incorporate 

more complexity in the north east corner. 

 

1. Use the Choose Feature Tool to select the existing Nazca Plate topology 

we created in Exercise 1 (Figure 13b). If you are having trouble with both 

layers visible, make the green Reconstructed Geometries Layer invisible, 

select the topology, and then make the green layer visible again. 

Alternately, when selecting a feature, in the bottom Topology Sections Table, 

there two features will appear since they sit on top of each other (Figure 

13a). You can select the feature you want to highlight in this table. 

 



 

Figure 13:​ ​a)​ Topology selected showing two features sitting on top of each other in the 

Topology Sections Table ​b)​ Nazca plate topology selected 

 

2. Click on the Edit Topology Tool button (Figure 14). 

 



 

Figure 14:​ Edit Topology Sections  

 

 

Notice that the topology will be drawn with the highlighting described above. 

The feature’s basic data is placed into the Topology tab of the Task Panel, 

and the Topology Sections Table will be filled with the list of boundary 

features (Figure 15). 

 

A) B)



 

Figure 15: a)​ Topology Sections Table showing the boundaries that are currently making 

up the topology ​b) ​Button to expand table into a separate window - useful when many 

topologies are involved 

 

3. Zoom to the North East Corner of the plate (Figure 16). This is the area 

where we want to edit the topology to incorporate more complexity. 

 

 

Figure 16:​ North east corner of Nazca plate 

 



4. In the Topology Boundary Sections Table, select the Subduction zone 

(Plate ID = 201) and move it to the bottom by clicking the down arrow on 

the left hand side of the row. The eastern boundary should now appear blue 

(Figure 17). This means that the new boundary sections that we add will be 

added after this (and before the green boundary section). 

 

 

Figure 17: ​Plate topologies ready to add more complexity after the South American 

Subduction zone (blue) and before the northern ridge isochron (green). 

 

 

5. Select the CAR-SAM boundary feature (Figure 18) and add it to the 

boundary. You should now notice that it appears blue (this means that the 

next boundary section we add will come after this). 



 

 

Figure 18:​ Editing the Nazca plate topology, CAR-SAM boundary feature highlighted before 

adding it to the boundary. 

 

6. Select the CAR-Cocos  Trench (Figure 19) and add it to the boundary.  

 



 

Figure 19: ​Editing the Nazca Plate - CAR Cocos Trench selected in white 

 

Your final plate topology should look something like Figure 20. 

 



 

Figure 20:​ New boundary sections added to the topology 

 

7. Now that we are happy with our modifications to the plate topology, click 

Apply… (on the Topology Tools section - right hand side of the screen). 

 

The north eastern corner of the Nazca plate should now appear slightly 

different and more complex to before (Figure 21). 

 



 

Figure 21:​ North eastern corner of Nazca plate more complex now that more boundaries 

are incorporated. 

 

Don’t forget to save your new layer if you need the changes you made! (File 

> Manage Feature Collections…) 

 

For more information about editing existing topologies, see ​Tutorial 5.1​, or 

the ​GPlates User Manual​.  
 

Exercise 3 – Incorporating a new MOR into an existing 

plate polygon dataset 

 

We will now interactively construct a MOR feature with the intention of 

replacing an existing MOR. This requires the user to ensure the new MOR 

geometry intersects with pre-existing plate boundaries so that it can replace 

an old MOR. The user then has to delete the old MOR, and manually edit 

existing topologies to insert the new plate boundary. When deleting a MOR, 

the user must fix at least two polygons at any one time. That is because the 

old MOR formed the mutual boundary between two polygons. 

https://docs.google.com/document/d/1qVHL-V4HSpcZeAiYBqUtbrwRNQcWLfLrTI0C9d7cVRI/pub
http://www.gplates.org/user-manual/


 

Users must also take care to correct any other polygon artefacts they may 

have introduced by deleting the old redundant MOR. GPlates does not 

automatically detect polygon artefacts, so a careful interactive 

reconstruction in GPlates through time is required to ensure polygon closure 

without gaps, overlaps or “rubber-banding” artefacts. 

 

For this example, we will create a new MOR in the Atlantic Ocean adjacent to 

the existing South America-Africa MOR, which exists between 60 and 20 Ma. 

 

1. If you are coming from Exercise 1 or 2, File > Clear Session (if beginning 

at this Exercise, open GPlates and go to Step 2) 

 

2. File > Open Feature Collection… > Open the following files from the 

tutorial data bundle: 

 

Coastlines: Seton_etal_ESR2012_Coastlines_2012.1.gpmlz 

Plate Polygons: Seton_etal_ESR2012_PP_2012.1.gpmlz 

Rotation File: Seton_etal_ESR2012_2012.1.rot 

 

3. Change the colour of the Plate Polygon Layer ONLY to colour by single 

colour - black (Features > Manage Colouring) 

 

4. In the Layers window (Window > Show Layers…), drag the pink 

reconstructed geometries layer to the top (Figure 22). 

 

 



Figure 22:​ Layers window showing the pink (resolved topological geometries) at the top. 

 

5. Reconstruct to 60 Ma and focus on the black MOR between at the junction 

of the South American (SAM) Plate and the African Plate (Figure 23). Note 

that the navy blue MOR which runs almost parallel to the black MOR is 

actually the isochron, and is not involved in the plate boundaries of the SAM 

Plate and the African Plate.  

 

 

Figure 23:​ The Atlantic Ocean, Africa and South America reconstructed at 60 Ma, centred 

on the South America-Africa MOR. 

 

  

6. Under the ‘Digitisation’ icon on the left, select ‘Digitise new polyline 

geometry’.  

 

7. Plot a series of points which span the length of the existing South 



America-Africa MOR (Figure 24). Note that your new MOR geometry must 

intersect the pre-existing plate boundaries of the two conjugate plates (SAM 

and Africa). Again if you plot an incorrect point, use the keyboard command 

Ctrl-Z to undo the action. The Appendix will detail how to extend a new MOR 

to intersect with existing boundaries if it doesn’t already. 

 

 

Figure 24:​ Digitise the new MOR to intersect the plate boundaries of the SAM and African 

plate. 

 

  

5. Click ‘Create Feature’ to open up the Create Feature window. Select 

‘gpml:MidOceanRidge’ as the feature type and specify all properties as 

before (i.e. Left and Right plate IDs of 201 and 701 respectively, the Begin 

and End time to 60 and 20 Ma respectively, and a new filename) and click 

Next (Figure 25). 

  



 

Figure 25:​ Specify all the properties of the new MOR feature in the ‘Create Feature’ 

window. 

 

  

6. Select the Plate Polygon (PP) dataset to save your new MOR to, and click 

Create. You will then be taken back to the main GPlates window where you 

can reconstruct back to 20 Ma to check whether your MOR is reconstructing 

correctly. 

 

Ideally, the endpoints of your MOR should continue to intersect the adjacent 

plate boundaries but in the situation in which they do not (Figure 26), refer 

to the Appendix before continuing. 

 



 

Figure 26:​ The southern end of the new MOR feature reconstructed at 20 Ma (circled) does 

not intersect with the pre-existing plate boundaries, and therefore must be modified. 

 

  

7. Select the first plate polygon to be edited (we will choose the SAM Plate), 

and then select ‘Edit Topology Sections’ under the ‘Topology’ icon (Figure 

27). 

 



 

Figure 27:​ Under the ‘Topology’ icon, select the SAM Plate using the ‘Choose Feature’ tool 

and then select the ‘Edit Topology Sections’ tool. 

 

 

8. Click the problematic boundary that needs to be replaced. In this 

example, there are two, both with Plate ID 296. It will be highlighted in the 

Topology Sections list at the bottom of the GPlates window.  

 

9. Click the down or up arrow next to the problematic boundary to specify 

the new insertion point for the newly created MOR – note that this can be 

done after deleting the old topology, but you may lose track of where the 

new MOR is supposed to be once you delete the old one.  

 

10. Click the “X” button to the left of both problematic MOR features to 

delete the old boundary from the topology (Figure 28). 

  



 

Figure 28:​ Select the two problematic MOR features and click the X button to remove 

them. 

 

Notice that a “rubber-banding” artefact will appear until you insert the new 

MOR boundary.  

 

11. Select the new MOR feature by clicking on it, and then click the ‘Add’ 

button on the right hand side of the main window (Figure 29). 

 



 

Figure 29:​ Select the new MOR feature and click the ‘Add’ button to add it to the existing 

topology. 

 

  

In the next window, notice that the ‘Valid time’ for which the topology can 

exist for is limited from 60.1 to 58.1 (Figure 30). This is because the plate 

polygon you are modifying will cease at 58.1 Ma (and transform into a ‘new’ 

one). The new MOR topology you have just incorporated into the polygon 

will similarly cease to exist at this point in time. If you select any feature, 

you will notice that the right-hand-side window will display the Valid time for 

which the feature will exist.  

 

12. Click Apply. 

 



 

Figure 30: ​The ‘Valid time’ for which the newly edited topology can exist for is limited by 

the existing ‘Valid time’ of the old topology.  

 

  

You have now successfully fixed one polygon.  

 

13. You must repeat this process on the other polygon (the Africa plate in 

this example) that shared the old MOR boundary. 

 

Once you have done this you will want to make sure that you have not 

created any artefacts or discontinuities. The best way to see gaps, overlaps 

and rubber-banding artefacts is by turning off the lines and just displaying 

the resolved topologies.  

 

14. In the Layers list, disable the Plate Polygon (PP) Reconstructed 

Geometries layer in the ‘Layers’ window.  

 

You can avoid these problems by carefully extending the new MORs to 

intersect at the same place as the old boundary (see Appendix). However, 

there is likely to be a lot of manual work to introduce new MORs into existing 

plate polygon datasets. 

 



For more information about editing MOR topologies, see ​Tutorial 5.2​, or the 

GPlates User Manual​.  
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Appendix 

 

Extending a new MOR to intersect with existing plate boundaries 

 

If intending to replace an existing MOR with a new MOR feature, it is crucial 

that the new MOR geometry intersects with pre-existing plate boundaries in 

order for the user to edit the new topology in. If the MOR fails to intersect 

these plate boundaries, which may be the case after reconstructing back 

through time, it is possible to interactively extend the MOR to intersect with 

the required plate boundaries. 

 

Using the ‘Choose Feature’ tool, select the problematic MOR and click the 

‘Insert Vertex’ tool (Figure 31). 

 

https://docs.google.com/document/d/1Jky8MMUlsXx9lcydRVSTPdKZDz77qUU_Mzy1qygPbA4/edit#
http://www.gplates.org/user-manual/
http://www.gps.caltech.edu/~gurnis/Papers/2012_Gurnis_etal_CAGEO.pdf
http://www.gps.caltech.edu/~gurnis/Papers/2012_Gurnis_etal_CAGEO.pdf
http://www.gps.caltech.edu/~gurnis/Papers/2012_Gurnis_etal_CAGEO.pdf
http://dx.doi.org/10.1016/j.cageo.2011.04.014


 

Figure 31:​ Select the MOR feature and click the ‘Insert Vertex’ tool. 

 

  

Add points to make the sure MOR intersects with neighbouring boundaries 

(Figure 32). 

  



 

Figure 32:​ Plot points interactively to extend the MOR until it intersects with adjacent plate 

boundaries. 

 

  

Once you are satisfied, select any other tool on the main interface (such as 

the ‘Choose Feature’ tool) to halt the process. You have now successfully 

extended your MOR feature! 


